
 

 

RATIONAL ACOUSTICS 

Smaart SPL 
 

USER GUIDE 

 

RELEASE 9.1 

  



 
 

Smaart SPL User Guide 2 Release 9.1 
 

 

 

 

 

 

 

 

Rational Acoustics Smaart SPL User Guide Copyright Notice 

 

Copyright ©2022, Rational Acoustics LLC. All rights reserved. Except as permitted by the United States 

Copyright Act of 1976, no part of this document may be reproduced or distributed in any form whatsoever or 

stored in any publicly accessible database or retrieval system without prior written permission from Rational 

Acoustics, LLC. Smaart, SmaartLive, Rational Acoustics and the Rational Acoustics logo are registered 

trademarks of Rational Acoustics, LLC. All other trademarks mentioned in this document are the property of 

their respective owners. 

 

 

For information contact: 

Rational Acoustics LLC 
32 Crabtree Lane 

Woodstock CT 06281 USA 
Telephone: (+1) 860 928-7828 

Email: info@rationalacoustics.com 
Web: http://www.rationalacoustics.com 

  

mailto:info@rationalacoustics.com
http://www.rationalacoustics.com/


 
 

Smaart SPL User Guide 3 Release 9.1 

TABLE OF CONTENTS 

1 – Introduction ...................................................................................................................................................... 5 

What is Smaart SPL? ........................................................................................................................................... 5 

What Is This guide? ............................................................................................................................................. 5 

A Note About Smaart’s Help Files ................................................................................................................... 5 

Hotkey and Mouse Click Notation .................................................................................................................. 5 

Full Scale (dBFS) versus Full Scale ................................................................................................................... 6 

Software Management ....................................................................................................................................... 6 

my.rationalacoustics.com ............................................................................................................................... 6 

Installing and Activating .................................................................................................................................. 6 

Basic Computer Requirements ....................................................................................................................... 7 

2 – SPL Concepts ..................................................................................................................................................... 8 

What Is SPL? ........................................................................................................................................................ 8 

SPL Is Logarithmic ........................................................................................................................................... 8 

Loudness vs Level ................................................................................................................................................ 9 

Understanding Loudness ................................................................................................................................ 9 

Why is SPL Measured? ...................................................................................................................................... 10 

Informational ................................................................................................................................................ 10 

Nuisance Noise .............................................................................................................................................. 11 

Sound Exposure ............................................................................................................................................ 11 

Frequency Weighting ........................................................................................................................................ 13 

The Genesis of Frequency Weighting ........................................................................................................... 13 

A-Weighting .................................................................................................................................................. 13 

C-Weighting .................................................................................................................................................. 14 

C-A Weighting ............................................................................................................................................... 15 

Z-Weighting (Unweighted)............................................................................................................................ 15 

Octave Banded Measurements .................................................................................................................... 15 

Time Weighting and Time Averaging ................................................................................................................ 15 

Exponential Average / Time weighting ......................................................................................................... 15 

Equivalent Continuous Level ......................................................................................................................... 16 

Peak / Instantaneous .................................................................................................................................... 16 

Calibration ......................................................................................................................................................... 16 

Accuracy and Compliance ............................................................................................................................. 16 

3 – Selecting Hardware for SPL Measurement ..................................................................................................... 19 



 
 

Smaart SPL User Guide 4 Release 9.1 
 

Microphone Maximum SPL ............................................................................................................................... 19 

Microphone Sensitivity ..................................................................................................................................... 19 

Sound Level Calibrators..................................................................................................................................... 19 

4 – Working With Smaart SPL ............................................................................................................................... 21 

Interface Tour .................................................................................................................................................... 21 

SPL History Timeline ...................................................................................................................................... 21 

Cursor Readout Area ..................................................................................................................................... 21 

Control Bar .................................................................................................................................................... 22 

Data Bar ......................................................................................................................................................... 22 

Menus............................................................................................................................................................ 22 

The Smaart v9 File Structure ............................................................................................................................. 22 

Managing Configurations .................................................................................................................................. 22 

Calibrating Smaart for SPL Measurement ......................................................................................................... 23 

Choosing Input signals................................................................................................................................... 23 

Calibration Procedure ................................................................................................................................... 25 

Gain Tracking ................................................................................................................................................. 27 

Display Config .................................................................................................................................................... 28 

Skins................................................................................................................................................................... 29 

Configuring Metrics ........................................................................................................................................... 30 

Custom Leq Metrics ...................................................................................................................................... 31 

Custom SPL Fast and SPL Slow Metrics ......................................................................................................... 31 

Custom Peak Metrics .................................................................................................................................... 31 

Custom Exposure Metrics ............................................................................................................................. 31 

Configuring Meters ........................................................................................................................................... 31 

Configuring Alarms ............................................................................................................................................ 32 

Logging .............................................................................................................................................................. 33 

Lollipop Markers ........................................................................................................................................... 33 

Working With the Meter Grid ........................................................................................................................... 34 

Working with Logfile Data ................................................................................................................................. 35 

Selecting a Time Range ................................................................................................................................. 35 

Statistical Analysis (Dynamic Range Statistics) ............................................................................................. 36 

Incomplete Files ............................................................................................................................................ 37 

Generating Reports ........................................................................................................................................... 37 

SPL Webviewer (Smaart API) ............................................................................................................................ 38 



1 – Introduction 
 

Smaart SPL User Guide 5 Release 9.1 

 

1 –  INTRODUCTION  

WHAT IS SMAART SPL? 

Rational Acoustics Smaart® SPL is a software application that enables you to measure, analyze, log, and 

remotely monitor sound levels. Smaart SPL is designed to provide a powerful and comprehensive sound level 

measurement toolset while maintaining an approachable and intuitive interface.  

Being a software application, Smaart SPL is hardware independent and can therefore be paired with a variety 

of microphones and interfaces, which allows its capabilities to scale from a single microphone logging 

application up to large, distributed systems that can monitor sound levels from a variety of locations using a 

networked audio protocol such as Audinate Dante®. 

WHAT IS THIS GUIDE? 

This guide is intended as a practical introduction to configuring and operating Smaart SPL. It will provide an 

explanation of the program’s features and operation. As many of the topics surrounding sound level 

measurement are commonly misunderstood, this guide will also provide some background on the core 

concepts that are critical to making effective use of Smaart SPL’s powerful toolset. 

This guide is organized so that it can be read from start to finish. We have attempted to provide information 

about program features and options organically and in context, so if you are searching for information on a 

specific function, the table of contents and index will help you track things down. In addition, a full text search 

can be done if you are reading an electronic copy of this document. 

You are also encouraged to consult Smaart’s built-in helpfiles, which contain much of the same information 

but is organized to mirror the program’s menus, dialogs and onscreen controls more directly. 

Due to the nature of sound level measurement at concert levels, we will discuss a few considerations for 

choosing measurement hardware that go above and beyond equipment considerations for general 

measurement work. In addition, we recommend that you visit our website for the most up-to-date list of 

minimum computer hardware requirements and compatibility information. 

A NOTE ABOUT SMAART’S HELP FILES  

Smaart includes a comprehensive set of help files, which can be accessed from within the program by clicking 

Help in the program’s menu bar (found at the top of the main program window on Windows operating 

systems, or across the top of the display on macOS computers). These helpfiles contain a concise reference for 

features and functions within Smaart and are intended as a companion to this user guide. The helpfiles and 

this user guide contain much of the same material but organized in different ways. While this guide attempts 

to group information conceptually, the helpfiles are organized to be in parallel with Smaart’s user interface, to 

allow you to quickly “drill down” through menus, dialogs, and on-screen controls to find what you are looking 

for.   

HOTKEY AND MOUSE CLICK NOTATION 
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Since Smaart SPL runs on both Windows and macOS, there are some minor differences in keyboard commands 

between the two versions. Specifically, the Control [Ctrl] key in Windows serves the same purpose as the 

Command [Cmd] key on macOS, and the [Alt] key in Windows is equivalent to the [Option] key on macOS. 

In this document, we’ll write the names of keys used for keyboard shortcuts (“hotkeys”) in brackets. In cases 

where Mac and Windows have different key names, both names will appear inside the brackets separated by a 

slash. For example, [Ctrl/Cmd] means the [Ctrl] key on Windows or the [Cmd] key on macOS. As regards the 

mouse, left-click on Windows is a regular mouse click on macOS. A right-click for Windows users means [Ctrl] + 

click on macOS. 

FULL SCALE (DBFS) VERSUS FULL SCALE 

There exist two competing references for decibels in digital audio signals. Once convention references dBFS to 

the largest possible amplitude value in a digital system, such that 0 dBFS denotes the maximum possible 

digital amplitude value. We refer to this as “normalized Full Scale.” 

The second convention, preferred by the Audio Engineering Society (AES), references 0 dBFS to the RMS value 

of a full-scale peak-to-peak sinewave (i.e. 0.7071 normalized Full Scale, rather than 1.0). We will call this “AES 

Full Scale.”  

In Smaart, Full Scale decibel values are always referenced to normalized full scale, meaning that the RMS level 

of a full-scale digital sinewave is -3.01 dBFS.  

 

SOFTWARE MANAGEMENT 

To get started, you will need to install Smaart onto your computer and activate the installation. 

MY.RATIONALACOUSTICS.COM 

The online account portal at my.rationalacoustics.com is the centralized location by which Smaart software 

licensing is managed. If you don’t already have an account, you should create one, and then you can register a 

new Smaart license by clicking the appropriately named “Register a new Smaart License” button on the 

Account Details page. 

You can also upgrade licenses and add installs and download installers for macOS and Windows computers. 

Click the Downloads tab in the navigation bar to access downloadable installers for all the versions of Smaart 

that are registered to your account, both for Windows and macOS. Take care to download the appropriate 

version.  

INSTALLING AND ACTIVATING 

Once the installer is downloaded, run it and follow the prompts. Smaart SPL licenses are perpetual, and must 

be activated online. More detailed information about the activation process can be found in the Licensing 

Guides that appear in the Documentation section of the support portal at RationalAcoustics.com. If you 

require assistance with the licensing process, please contact Rational Acoustics support.  
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Following installation, the first time you run Smaart, you will be presented with an activation screen asking 

you to select your license type – perpetual or subscription. The next page will ask for your license code, 

followed by your my.rationalacoustics.com account information. The final screen will ask for your name and 

email address, as well as a Computer Name identifier of your choice. Then click Activate to activate your 

license. 

BASIC COMPUTER REQUIREMENTS 

You can find the most up-to-date minimum system requirements for Smaart v9 on our website at 

rationalacoustics.com. The minimum system requirements for Smaart v9 have changed from v8, and may be 

updated as new hardware, operating systems and program features become available. These minimum 

requirements are established to ensure reasonable performance when default settings are used. You should 

consider a more powerful computer if you plan to run many measurements at the same time.  
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2 –  SPL CONCEPTS 

In this chapter, we offer an overview of some core concepts that are important for SPL measurement and 

analysis. Due to the historical roots of sound level measurement and the inherent ties with hearing 

perception, a review of this information is recommended for all users. 

WHAT IS SPL? 

Sound Pressure Level (SPL) is a measure of the strength of air pressure variations caused by a sound wave. As 

sound waves travel, they force air into rapidly alternating states of high and low pressure (compression and 

rarefaction), and SPL is a measurement of the magnitude of those changes. 

SPL measures pressure deviation, not ambient air pressure itself. To use a metaphor of a cork floating on the 

surface of the ocean, we’re interested in how far the cork bobs up and down with passing waves, not 

measuring sea level. 

Sound Pressure Level measurements are stated in decibels (dB SPL), which means they communicate a value 

by comparing it to an established reference. The reference for dB SPL that 0 dB SPL is set equal to a pressure 

fluctuation of 0.00002 Pascal (20 µPa). This is an extremely small pressure fluctuation that deflects the human 

eardrum by about the diameter of a hydrogen atom, and is roughly comparable to the quietest sound a 

human being can perceive under controlled conditions.  

It also works out that 94 dB SPL is almost exactly equal to 1 Pascal (a unit of pressure equal to 1 Newton per 

square meter). Many sound level calibrators produce 94 dB SPL because it’s a convenient “round number” 

value from a mathematics and engineering perspective. The threshold of physical pain lies somewhere around 

120 to 130 dB SPL, which means that all the sounds you experience in your day-to-day existence (hopefully) 

fall between those two extremes. 

SPL IS LOGARITHMIC 

In mathematical terms, SPL is equal to twenty times the base ten logarithm of ratio of the rms (root mean 

square) sound pressure to the reference level of 20 µPa. This can be stated as  

𝑆𝑃𝐿 = 20𝑙𝑜𝑔10 (
𝑝

𝑝𝑟𝑒𝑓
) 

where 𝑝 is the measured sound pressure and 𝑝𝑟𝑒𝑓 is the reference level of 20 microPascals. 

Each 20 dB increase in SPL equates to a tenfold increase sound pressure. This allows us to compress the 

enormous range of sound pressures that human hearing is sensitive to (about a million to one) into a useful 

120 dB range.  

Another benefit of the logarithmic (dB) scale is that it is a closer approximation to our hearing perception, 

which responds to “percent change.” In other words, we perceive a small increase to a low-level signal 

similarly to how we perceive a larger increase in a high-level signal, and the same “percent change” in both 

instances can be represented by the same dB value. 
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LOUDNESS VS LEVEL 

It might be tempting to think of SPL as “how loud a sound is” but that’s not accurate. SPL is a measured level – 

that is, an objective measure of a physical quantity, just like height or weight, whereas loudness describes 

human perception, which is subjective and influenced by a number of factors besides SPL, including tonal 

balance, crest factor, intelligibility, the presence of distortion, and even listener preference for the program 

material. Understanding the distinction between loudness and level is critical to gleaning useful information 

from SPL measurement data. 

For example, when listening to reinforced speech in low-intelligibility environments, people will often request 

for the operator to “turn it up,” because the lack of intelligibility can cause a perception that the signal isn’t 

loud enough. Likewise, mix engineers are familiar with the technique of using small amounts of harmonic 

distortion to increase the perceived loudness and presence of a signal without significantly increasing its level. 

Music playback at a certain SPL might be deemed far too quiet for a concert setting on Saturday night, and far 

too loud for a worship service the next morning – because even the context and physical setting play into our 

loudness perception. These are just a few examples of how, although level and loudness are certainly related, 

they are very different concepts. 

An important result of this distinction is that our loudness perception is not able to reliably tell us whether 

sound levels are safe. It is possible to feel completely comfortable despite being exposed to unsafe sound 

levels, and it is also possible to feel that a sound is “too loud” when it’s objectively safe. 

As with all measurement tools, the way forward lies in choosing the appropriate tool to answer the specific 

question that is being asked. If the questions are perceptual and artistic in nature (“Is the balance of this mix 

pleasing to the ear,” or “Is it artistically appropriate for this performance to be this loud?”), trained ears and 

experienced listening skills will provide the answers.  

SPL measurement tools come to the forefront to provide objective answers to objective questions, such as “Is 

the show tonight the same level as the show last night,” “are we violating the noise ordinance,” or “are these 

sound levels harmful?” 

UNDERSTANDING LOUDNESS 

You may have encountered the statement that a 10 dB increase in SPL will be perceived as “twice as loud,” 

however due to the inherent divide between level and loudness, this is best viewed as a rough rule of thumb. 

For example, the dB increase needed to produce a doubling of perceived loudness is much smaller in the low 

frequency region. Experienced mix engineers exploit this divide to achieve mixes that feel loud and impactful 

at safe sound levels. 
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Figure 1 - Equal - loudness contours (red) and  Fletcher-Munson curves (blue) 

Formal attempts to quantify the relationship between SPL began when Harvey Fletcher and Wilden A. Munson 

published their research on the subject in 1933. Although their findings differ significantly from the currently 

accepted values, the work inspired further experimentation which resulted in the modern Equal Loudness 

Contours, standardized as ISO 226:2003. Figure 1 shows the original Fletcher-Munson curves in blue and the 

current Equal Loudness Contours in red. 

The Equal Loudness Contours describe how our perception of tonal balance changes with level. At low levels, 

our hearing is most sensitive to frequencies around 3 kHz and rolls off towards the extremes of the audible 

spectrum, particularly the low frequency. As level increases, our response becomes less biased and tends 

toward a flatter response (although it does not flatten out completely, even at concert levels). Thus, a mix that 

sounds balanced at high levels might not also sound balanced at lower levels, providing a scientific basis for 

the liner notes of the Rolling Stones’ 1969 album Let It Bleed (“THIS RECORD SHOULD BE PLAYED LOUD”). 

WHY IS SPL MEASURED? 

If a sound level meter isn’t used to tell us “How loud it is,” then why use it? There are three primary 

motivations for taking a sound level measurement.  

INFORMATIONAL 

Often, sound level measurements are used for informational purposes, even though the measurement may 

not be required by any applicable policy or legislation. In the context of live events, sound level measurements 

are a powerful tool to help ensure consistency from show to show, a sort of “quality control” for the audience. 

Realtime sound level meters help provide mix engineers immediate visual feedback to help them control their 

levels and dynamic range throughout a performance. 

In houses of worship, for example, which may offer several services on a weekend, mixed by different mix 

engineers or a team of volunteers, sound level monitoring is used to ensure that all the services maintain a 

similar level and dynamic footprint regardless of who is mixing.  
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Many live event spaces gather sound level measurements whenever a sound system is in use in the space, and 

the log data is kept on file in case any concerns about level policies need to be addressed after the fact. 

NUISANCE NOISE 

Nuisance noise regulations are common in many populated areas, where the sound from live events or loud 

music playback can carry across property lines and disturb people in nearby residences. The primary goal of 

many noise ordinance regulations is reducing noise pollution and nuisance to parties outside or adjacent to 

the event area. Nuisance regulations often require events to keep their levels under a certain limit as 

measured from the property line in question. A measurement taken at FOH mix position does not necessarily 

correlate to what the level will be in the far field, as the distance a sound system will carry depends on how it 

is designed as well as multiple environmental factors, however, once a rough correlation has been established 

between the two locations, setting a sound limit as measured from the FOH mix position is typically the most 

actionable way to address these concerns.  

However, many of these nuisance regulations are poorly written, set arbitrary / unrealistic limits, use language 

that is too vague to be meaningful or enforceable, or specify an A-Weighted limit, which is ineffective because 

A weighting is insensitive to LF energy, often the most problematic from a nuisance noise point of view. 

 

SOUND EXPOSURE 

It is well established that both short-term and long-term exposure to high sound pressure levels can cause 

hearing damage. Sound exposure is a measure of total sound energy over a period of time. High sound levels 

increase a person’s total sound exposure more quickly. Thus, there is not a single-number dB SPL value that 

can be considered “safe” or “unsafe,” because it depends on the amount of time a person is exposed to that 

sound. Conceptually, sound exposure depends on both “how loud” and “how long.” 

In Smaart, sound exposure metrics function as dosimeters, with the meter reading the total sound exposure in 

percent dose. Smaart offers two different sound exposure dosimeter models, one based on OSHA’s 

Permissible Exposure Limits (PELs) and one based on NIOSH’s Recommend Exposure Limits (RELs). 

OSHA (Occupational Safety and Health Administration) issues PELs for sound 

exposure in an occupational setting. The OSHA exposure dose is based 90 dBA for 

an eight-hour time-weighted average (see Leq, above). The context of the 

standard is workplace safety, which is the basis for the 8-hour exposure time. The 

PEL for other durations is determined using a 5 dB exchange rate, which means 

that every 5 dB level increase cuts allowable exposure time in half. This means the 

PEL for a one-hour concert would be 105 dBA. 

The chart at left shows the OSHA PEL for various exposure durations. Maximum 

level for a given exposure time H in hours can also be estimated with the formula SPL = 105 – 16.6logH. It is a 

common misconception that observing OSHA exposure limits will protect against hearing damage. The OSHA 

limits are not intended for hearing loss prevention; they indicate the levels at which employers are legally 

obligated to protect their employees. In other words, use the OSHA sound exposure measurements (Exposure 

O in Smaart) to answer questions about whether sound levels constitute a workplace safety hazard from a 

legal perspective. 

OSHA PEL 

Sound level 
(dBA) 

Duration 
(Hours:Minutes) 

85 16:00 

90 8:00 

95 4:00 

100 2:00 

105 1:00 

110 0:30 

115 0:15 

120 0:07 
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By contrast, NIOSH (National Institute for Occupational Safety and Health) issues 

RELs (Recommended Exposure Limits) which aim to protect hearing by reducing 

the risk of noise-induced hearing loss. The NIOSH limit is 85 dBA for an eight-hour 

time-weighted average. Unlike OSHA, the NIOSH standard uses an exchange rate 

of 3 dB, which is consistent with the current scientific consensus.1 (Since 3 dB 

represents a doubling of power, it follows that the same exposure limit will be 

reached in half the time.) The chart at left shows the NIOSH REL for various 

exposure durations. Maximum level for a given exposure time H in hours can also 

be estimated with the formula SPL = 94 – 10logH. Use NIOSH exposure dose 

measurements (Exposure N in Smaart) to answer questions about whether an 

event presents a hearing health risk. 

A-Weighting (see Frequency Weighting on page 13) is used for most health and safety regulations concerning 

sound exposure, although it may not be intuitively obvious why this is the case, as the A-Weighting curve 

bears little resemblance to the tonal response of human hearing at high levels. However, the current 

audiological consensus is that that A-Weighted sound level measurements correlate well with statistical data 

on noise-induced hearing loss, and reasonably approximate the diffuse-to-DRP transfer function of the human 

hearing mechanism. For this reason, the A Weighting curve is considered by audiological experts to be 

effective at characterizing sound exposure risk.2,3 

However, additional research has shown that LF energy can present a hearing health risk at high levels.4 For 

this reason, many sound level limits specific a secondary C-weighted limit. 

Human hearing employs several mechanisms that act to temporarily desensitize the inner ear in the presence 

of high sound levels, to reduce the amount of energy hitting the cochlea. This loss of sensitivity is called a 

threshold shift. The excess energy causes stress and fatigue in the hair cells (stereocilia) of the inner ear, and 

in some cases the loss can become permanent.  

It is important to note that the discomfort (or lack thereof) in the presence of loud sounds is not a reliable 

indicator of whether a noise level is safe from a hearing health standpoint. Some people think that they’ve 

“conditioned” their ears to be more resistant to loud noises. In reality, this is not the case, since repeated 

exposure to high sound levels can raise the discomfort threshold, so you can “feel fine” and still be subjected 

to potentially damaging sound levels. 

 
1 https://www.cdc.gov/niosh/docs/98-126/pdfs/98-126.pdf?id=10.26616/NIOSHPUB98126 
2 https://www.who.int/pbd/deafness/Hearing_loss_due_to_recreational_exposure_to_loud_sounds.pdf 
3 https://www.who.int/activities/making-listening-safe 
4 https://www.aes.org/technical/documents/AESTD1007_1_20_05.pdf 

NIOSH REL 

Sound level 
(dBA) 

Duration 
(Hours:Minutes) 

82 16:00 

85 8:00 

88 4:00 

91 2:00 

94 1:00 

97 0:30 

100 0:15 

103 0:07 
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FREQUENCY WEIGHTING 

Smaart SPL offers multiple options for 

frequency weightings, including A-, C-, Z- 

(unweighted), and octave-banded filters. 

When discussing SPL measurement values, it is 

always important to state which frequency 

weighting was used, since different weightings 

produce different values. Care should be taken 

to choose the appropriate frequency 

weightings for the measurement task at hand, 

as some are more useful than others 

depending on what we are hoping to learn. 

THE GENESIS OF FREQUENCY 

WEIGHTING 

Although accounts are sparse, it is generally 

accepted that the Fletcher-Munson research was used as the basis for a series of frequency weighting curves 

that were originally intended to alter the response of sound level measurements in a way that mimics the 

tonal response of human hearing at various levels, with the goal of creating a measurement that “looks like it 

sounds.” The A-Weighting curve, for example, is a rough match for the inverted original 40-phon contour. The 

intent was that the user would apply different weighting curves based on the measured level to allow the 

reading to match their expectations more closely. 

Besides the technical flaws in this approach (the standardized curves departed from the already-inaccurate 

Fletcher-Munson results to make the filters easier to implement with the analog electronics of the day), there 

is a more fundamental conceptual pitfall, in the form of circular reasoning: We use weighting curves to change 

the measured level, while the measured level is used to choose the weighting curve. One must question the 

point of taking an objective measurement and then weighting it until we feel better about the result – it would 

be like changing the calibration on one’s bathroom scale until it reads a more flattering weight. 

We can dodge this bullet entirely by remembering that SPL is not an indicator of perceived loudness, but 

rather a tool to answer objective questions about sound level. Despite their well-intentioned but misguided 

historical roots, the A- and C-Weighting curves remain useful in modern SPL measurement applications. The 

fact that the B-Weighting curve, despite being the most appropriate match for the tonality of human loudness 

perception at concert levels, has since been removed from most applicable Standards and sound level 

measurement devices, speaks to the fact that modern sound level measurement tools are not intended to 

answer questions about perceived loudness.5 

A-WEIGHTING 

The A Weighting curve consists of a significant low-frequency roll-off, exhibiting an attenuation of about -20 

dB at 100 Hz, in combination with a slighter high-frequency roll-off. A-Weighting tends to correlate well with 

energy that lies in the human vocal range, and is commonly used for real-time level monitoring by concert mix 

 
5 It should therefore come as little surprise that “Loudness” measurement algorithms such as ITU-RE BS.1770-3, intended 
specifically to characterize the perceived loudness of digital signals, do use a modified version of the B weighting curve. 

Figure 2: Z-, C-, and A-Weighting curves 
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engineers. As such, the majority of sound 

level limit policies at live events specify an A-

Weighted limit as averaged over a period of 

time.  

In addition, many environmental and 

nuisance noise regulations on the books in 

the United States specify A-Weighting. 

Although this is largely a holdover from the 

now-defunct Noise Control Act of 1972, A-

Weighting is a poor choice for nuisance noise 

applications, particularly in the context of 

live events. This is because the low 

frequencies, which are most likely to 

propagate far distances outdoors and 

transmit most efficiently through structures, 

and therefore most likely to generate noise 

complaints, are de-emphasized by the A-

Weighting curve, leaving the measurement unable to accurately characterize the sounds it is designed to 

regulate.  

A-Weighting is also used for most health and safety regulations concerning sound exposure, although it may 

not be intuitively obvious why this is the case, as the A-Weighting curve bears little resemblance to the tonal 

response of human hearing at high levels. However, the current audiological consensus is that that A 

Weighted sound level measurements correlate well with statistical data on noise-induced hearing loss, and 

reasonably approximate the diffuse-to-DRP transfer function of the human hearing mechanism. For this 

reason, the A Weighting curve is considered by audiological experts to be effective at characterizing sound 

exposure risk.6,7 

However, additional research has shown that LF energy can present a hearing health risk at high levels.8 For 

this reason, many sound level limits specific a secondary C-weighted limit (see following). 

C-WEIGHTING 

The C-Weighting curve is effectively broadband, exhibiting a slight roll off at the frequency extremes. For this 

reason, C-Weighting is commonly used to characterize broadband content such as live music, including the 

subwoofer region. The slight rolloffs are sometimes considered useful for restricting the measurement to the 

range of energy commonly emitted by a sound system, and de-emphasizing low frequency structure-borne 

vibrations, rumble, and so forth. It is often stated that C-Weighting resembles the tonal response of human 

hearing at concert levels. However, in Figure 3 which compares the A- and C-Weighting curves against the 100-

phon Equal Loudness Contour, we see that this is not the case.  

 
6 https://www.who.int/pbd/deafness/Hearing_loss_due_to_recreational_exposure_to_loud_sounds.pdf 
7 https://www.who.int/activities/making-listening-safe 
8 https://www.aes.org/technical/documents/AESTD1007_1_20_05.pdf 

Figure 3 - A- and C-Weighting vs 100 phon ELC 
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Thus it is better to stick by the rule of thumb that we want to use C-Weighting for when we wish to include 

most of the low frequency energy in our measurement, and A-Weighting for when we don’t. 

 

C-A WEIGHTING 

C-A Weighting is exactly what it sounds like – the difference between the C-Weighted and A-Weighted sound 

levels. C-A weighted measurements will show low values when most of the signal’s energy is concentrated 

higher in the frequency spectrum, such a speech signal, and higher values when more of the energy is 

concentrated at low frequencies, such as live music. C-A is often used as an indicator of overall spectral 

balance of a mix, and is useful for evaluating potential low frequency sound exposure risk.  

The current recommendation from the AES Technical Committee on Acoustics and Sound Reinforcement is 

that when the measured C-A exceeds 20 dB, that is an indicator that the signal contains significant energy 

distributed in the low-frequency region and the traditional A-Weighted sound exposure metrics may not fully 

characterize the potential risk.  

Z-WEIGHTING (UNWEIGHTED) 

Unweighted (also called “Z-weighted”) measurements are taken with a flat frequency response or, in other 

words, no frequency weighing applied to the measurement. It is most often used when the measurement 

needs to accurately characterize energy at the extremes of the audible range (below 30 Hz and above 10 kHz). 

It is of limited use in live sound applications but it can be useful for loudspeaker testing applications and 

acoustical evaluations.  

OCTAVE BANDED MEASUREMENTS 

Smaart SPL offers the ability to measure sound levels in octave-wide bands, on center frequencies from 16 Hz 

through 16 kHz. This is useful to study and document how sound level energy is distributed over frequency. 

For example, examining energy within the 63 Hz octave band can help indicate whether a level overage 

occurred because of the PA system, or a cheering crowd. Octave-banded sound level data can also help 

characterize nuisance noise along a property line. 

TIME WEIGHTING AND TIME AVERAGING 

Besides frequency weighting, another important consideration when measuring sound level is how we treat 

the signals in the time domain. Since real-world signals change in level from moment to moment, our 

measurements can produce different results depending on if they look at the signal over shorter or longer 

periods of time. Sound level measurements in Smaart fall into three different categories of time-domain 

weighting: exponential average, equivalent continuous sound level (Leq), and Peak (instantaneous level). 

 

EXPONENTIAL AVERAGE / TIME WEIGHTING 

Exponential averaging, also sometimes referred to as time weighting, is the meter ballistic that is the most 

common on basic sound level meters. It comes in two varieties, SPL Fast and SPL Slow. Conceptually speaking, 

exponential averaging is like applying a low-pass filter to the signal in the time domain, which “damps” the 
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reading against quick jumps but keeps the reading trending towards the current level. This time constant 

behavior is similar to the behavior of a charging capacitor, or the movement of the needle on a VU meter. 

SPL Slow uses a time constant of 1 second, and SPL Fast uses a time constant of 125 milliseconds. Although 

these two time weighting options are the most commonly available, and are popular choices for mix engineers 

to keep an eye on during events, they don’t offer enough context to allow us to make meaningful statements 

about level trends over time. 

EQUIVALENT CONTINUOUS LEVEL 

A very useful metric for sound level monitoring applications is Equivalent Continuous Sound Level, or Leq. Leq 

is a measurement of total sound energy over a period of time, presented as a single dB value. It can be 

thought of as “area under the curve,” or an answer to the question “what is the equivalent steady-state level 

over the same amount of time?” Since live events tend to have high dynamic range and high crest factor, Leq 

is typically the most useful metric for evaluating level trends (“what was the level of the last verse / song / 

set?”). For this reason, Leq measurements spanning ten or fifteen minutes are the most implemented sound 

level limits at live events. 

The number in the suffix indicates the measurement period in minutes (Leq 1, Leq 10, etc). For brevity, the 

frequency weighting used is commonly indicated in the suffix as well (LAeq 10, LCeq 15, etc). In Smaart SPL, 

you can configure an unlimited number of Leq measurements with averaging times from 1 second to 24 hours. 

PEAK / INSTANTANEOUS 

The “Peak” measurement always shows the maximum instantaneous level reached within a measurement 

interval. It is useful for evaluating compliance with regulations seeking to protect employees against high level 

impulses such as those created by industrial machinery, explosives, and firearms. The C-Weighted variant 

(Peak C) is often used as a secondary limit for sound level regulation at live events to protect the audience 

from intense broadband events.  

CALIBRATION 

Since Smaart is a software application that can analyze audio signals from a wide variety of sources, it doesn’t 

know what acoustic level at the microphone caused the digital signal values that it’s seeing. The process of 

calibration involves producing a known acoustic level at the microphone, so Smaart can draw a correlation 

between a digital signal level and the acoustic level that caused it. This allows Smaart to establish the 

sensitivity of the entire measurement signal chain from microphone to convertor. Once Smaart has been 

calibrated, it will be able to accurately display sound level measurements. The calibration process is covered in 

detail on page 25. 

 

ACCURACY AND COMPLIANCE  

When it comes to equipment used for sound level measurement, achieving higher accuracy typically requires 

more costly hardware, so it’s a good idea to evaluate your requirement for accuracy before making purchases. 

The accuracy required depends heavily on the goal of the measurement. A mix engineer who is simply looking 
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to ensure night-to-night consistency has no requirement for accuracy – even a poorly-calibrated measurement 

is useful, as long as it is stable over time – by allowing the mixer to “hit the same numbers” every night. 

If the measured value needs to be meaningful – for example, when evaluating compliance with sound level 

regulations, then accuracy is important, as decisions will be made based on that level data. Sound exposure 

measurements have the highest requirement for accuracy. Consider that a calibration error of 3 dB equates to 

a 100% error in NIOSH sound exposure, which can result in individuals being exposed to twice the intended 

noise dose. THE FIGURE BELOW shows the relationship between calibration error and uncertainty in exposure 

time. 

 

It is our recommendation that, for critical measurement applications such as compliance or sound exposure, 

accuracy should be within +/- 1 dB tolerances. 

STANDARDS 

IEC standard 61672-1 sets forth two categories for sound level meters, Class 1 and Class 2, with Class 1 being 

the more stringent specification. The standard dictates a variety of performance specifications covering every 

part of the metering and logging process, from mic tolerances and windscreens all the way through to data 

logging format and how the interface presents measurement data to the user. Probably the most relevant 

difference is the frequency response tolerances of the microphones used for logging. They are quite similar for 

most of the audible band, but a Class 1 microphone must fall within more stringent tolerances at the extremes 

of the spectrum.  
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COMPLIANCE 

In the context of SPL metering, we use the term “compliance” to describe being in accordance with 

established standards. Given the rather serious consequences of error – hearing damage and potential legal 

trouble, to start – it is important that we can trust the data we are collecting. Note that compliance is not 

strictly a question of accuracy –  a high-quality measurement mic, connected to Smaart SPL via a high-quality 

audio interface, and calibrated with a high-quality calibrator, will certainly provide an accurate measurement. 

It is not, however, a legally verifiable measurement, and so does not rise to the standard of “Class Compliant”. 

By contrast, class-compliant systems such as the 10EaZy system are “closed” measurement chains – the 

hardware is designed to comply with IEC 61672-1 standards, manufacturer-calibrated before it is sold, and 

cannot be altered or tampered with in the field. The resulting logfiles therefore have sufficient integrity to be 

admissible as evidence in a court of law or legal proceeding.  

In many jurisdictions, violations can carry hefty fines, so it is important to consider whether your SPL metering 

needs would be better met with class-compliant hardware, along with whether you want to leave the 

determination in the hands of a well-meaning local official with an inexpensive handheld meter or 

smartphone. In these situations, a good (class-compliant) offense can be the best (legal) defense. 

Of course, Class-Compliant level hardware systems can be significantly more costly than a non-class compliant 

system capable of producing the same measurement data within the same margins of accuracy. Therefore, the 

question of whether Class-Compliant hardware is worth the extra investment for your application could be 

framed as “Do we just need to know what the levels are, or do we need to be able to prove it?”  
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3 –  SELECTING HARDWARE FOR SPL MEASUREMENT  

SPL measurement at concert levels places some unique demands on the measurement equipment, and we 

must consider these to achieve optimal results and dependable data.  

MICROPHONE MAXIMUM SPL 

At concert levels, the measurement microphone in the audience area is subjected to acoustic pressures 

several orders of magnitude higher than during a typical measurement session. As a rule of thumb, for typical 

live music material, the instantaneous peaks seen by the microphone will be approximately 35 dB above the 

average A-weighted SPL. Analysis of sound level data gathered over the course of many live events suggests 

that the measurement microphone should be rated for a Max SPL of at least 135 dB – 140 dB to safely 

accommodate these instantaneous peaks without overload. Although infrequent overload events may not 

cause much concern in the context of live sound mixing, when it comes to SPL measurement, even occasional 

overloads are problematic as they flush averaging buffers and potentially invalidate large time ranges of log 

data. As many measurement microphones are driven into severe distortion at concert levels, it is important to 

confirm the Max SPL specifications of the chosen microphone to be certain that it can perform cleanly at these 

levels. 

MICROPHONE SENSITIVITY 

After Max SPL, the next thing to consider is the voltage that the measurement mic creates at its maximum 

input level. Microphones with high sensitivity will produce large voltages that can overload a typical mic 

preamp. Therefore, the microphone and audio interface must be chosen to work together as a pair, by 

selecting an interface whose inputs can accommodate the voltages created by the microphone during the 

event. 

Measurement microphone sensitivity is usually indicated as mV / Pa, which is the output voltage created when 

the capsule is exposed to 94 dB SPL (1 Pascal). Since our target of 140 dB SPL is, in linear terms, 200 times 

greater than 94 dB SPL, you can quickly determine the mic’s output voltage at 140 dB SPL by multiplying its 

sensitivity by 200. 

For example, if your measurement mic has a sensitivity of 36 mV/Pa, then at 140 dB SPL, it will produce an 

output voltage of 7.2Vrms (+19 dBu), which may overload the microphone preamps on many interfaces. A 

lower sensitivity measurement microphone, with a sensitivity of about 6 mV/Pa, for example, would produce 

about 1.2Vrms (+3.8 dBu) at 140 dB SPL, which can be comfortably accommodated by the preamps on most 

audio interfaces. 

SOUND LEVEL CALIBRATORS 

A sound level calibrator is used to produce a known SPL at the diaphragm of the microphone, which Smaart 

can correlate with the incoming signal level, thus establishing the sensitivity of the entire signal chain, from 

mic to interface.  

There are two basic types (electronic and piston-phone) and three standardized classes of accuracy (Classes 1, 

2, and LS). Class LS calibrators are intended for lab use and are seldom seen by most humans. Class 1 devices 
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have output tolerances of +/- 0.4 dB, and Class 2 devices have output tolerances of +/- 0.75 dB.  Most 

calibrators generate a 1 kHz, although some produce lower frequencies such as 250 Hz.  

Sound level calibrators, like microphones, are not all created equal. A fully class compliant calibrator will 

always come with a certificate of calibration, ensuring that it meets all standardized requirements for its 

classification. If a calibrator does not come with a certificate of calibration, all bets are off. We have seen 

inexpensive calibrators vary by as much as 2 dB from a Class 1 reference device, and as much as 3 dB from unit 

to unit. For sound exposure measurements (NIOSH REL), 3 dB represents 100% error, which is far too 

inaccurate to be meaningful.  

 

A realistic goal for SPL calibration accuracy is to be within +/- 1 dB, and that can be easily accomplished with a 

well-made and certified Class 2 calibrator or better. As with microphones, full compliance testing adds 

significantly to production costs. If you don’t see any mention of calibration and it’s a lower cost device, then 

you probably want to assume that only a less stringent production line test of some kind was done. 
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4 –  WORKING WITH SMAART SPL 

We’ll start by taking a tour through the major elements of the Smaart SPl graphical user interface (GUI). 

INTERFACE TOUR 

The Smaart SPL user interface consists of a central SPL History Timeline display area, which is flanked by the 

Data Bar on the left side (highlighted in red in the figure below), the Control Bar on the right  (highlighted 

gold), a docked meter bridge above (purple) and time range statistics below (blue).  

 

Figure 4 - the Smaart SPL user interface. Data Bar in red, Control Bar in gold, docked meter bridge in purple, time range statistics in blue, 

and the SPL history timeline in the center, divided into the navigation pane (pink) and the detail pane (green). 

SPL HISTORY TIMELINE 

The SPL History Timeline is divided into two panes. The upper pane is the Navigation pane, which always 

shows the entire duration of the currently displayed logfile, and is shaded pink in the figure above. The lower 

pane is the Detail pane, which allows you to zoom in on a designated time range and view multiple metrics 

overlaid at once, and is shaded green in the figure above. 

CURSOR READOUT AREA 

One of the most important analysis tools in Smaart is the mouse cursor. In addition to operating the program’s 

controls, the cursor is used to find precise values for any point of interest in the SPL History Timeline. When 

you position the cursor over data in the plot, the Cursor Readout Area at the top of the history timeline 
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displays information about the data under the cursor. The text in the cursor readout area is color-coded to 

match the data it describes. 

 

Figure 5 - The cursor readout area displays information about the data under the cursor. Note that the cursor readout is color coded to 

match the data in question. 

CONTROL BAR 

The Control Bar is found along the right side of the main program window. The Control Bar, true to its name, 

houses controls for the common functions in Smaart SPL. At the top of the Control Bar is a docked clock that 

displays the current system time.  

DATA BAR  

The Data Bar, located along the left side of the program window, is home to stored logfile data. Once logging 

is stopped, the logfile will appear in the data bar. The Data Library is a live view of the stored data files in your 

computer’s Documents folder, inside the Smaart SPL\Data\SPL Logs subdirectory. 

MENUS 

Smaart’s main menus span the top of the program window on Windows, and the top of the display on macOS. 

The top-level menus collect functions into general categories (File, Config, Options, View, Window, and Help). 

In this guide, carets will indicate the navigation path through the menus and any submenus. For example, 

Options > Preferences means to open the Options menu and select Preferences. 

THE SMAART V9 FILE STRUCTURE 

Smaar sPLt stores all its captured measurement data and configuration data in your computer’s Documents 

directory, in a folder called Smaart SPL. Inside the Smaart SPL folder are several subfolders, including the 

Config folder, which houses Smaart’s config data and any saved configurations, and the Data folder, where 

saved measurement data is kept, in a subdirectory named SPL Logs. 

 

MANAGING CONFIGURATIONS 

The Manage Configurations dialog, accessible from the Config menu, will allow you to save the current 

configuration at any time by clicking Save As, entering the name for the configuration, and clicking OK. The 

Restore Defaults button will completely restore Smaart to its default state, including all configurations and 

settings. This can be helpful for troubleshooting purposes as well. 
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Choose a stored configuration from the list and click Recall, and confirm with Yes to restore it.  Use the Delete 

button to delete a stored configuration, Copy to duplicate it, and Overwrite to update the stored configuration 

with the current program configuration.  

 

Figure 6 - the Config Management dialog 

 

CALIBRATING SMAART FOR SPL MEASUREMENT 

All of the measurement data produced by Smaart is produced by analyzing the incoming digital signals. Sound 

level measurements are unique in that they directly describe the strength of the fluctuations in air pressure 

occurring at the microphone location. In order to produce SPL measurement data, Smaart needs to know what 

acoustic level at the microphone caused the incoming signal levels. This is accomplished by running the sound 

level calibration routine.  

Configuring Smaart SPL to measure sound level data is a two-step process. First, selecting the input devices 

and input channels you wish to use, and then calibrating those input channels for sound level measurement. 

CHOOSING INPUT SIGNALS 

In order to start our work, we need to get input signals into Smaart – we do this by selecting which input 

device(s) we wish to use, and which channels on those devices. This is done in the Input Config dialog, which 

Smaart will automatically display on first launch. You can also access the Input Config dialog at any time by 

clicking Config > Input Config or via the hotkey [Alt/Option] + [A]. 
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Figure 7 - the Input Config dialog 

The IO Config dialog in other editions of Smaart v9 (Suite, RT and LE) has two tabs, Input and Output. Since 

Smaart SPL only monitors incoming signals but doesn’t produce any output signals of its own, its IO Config 

dialog only has a single tab, labeled Input.  

At the top of the Input tab is the devices table, which lists all audio devices that your operating system 

recognizes. While previous versions of Smaart required devices to be connected and recognized by the 

operating system before launching the software, Smaart v9 can dynamically detect input devices connected at 

any time. Once you connect your device, it should populate in the top pane of the IO Config dialog after a 

short delay, provided the proper drivers are installed.  

To select a device for use in Smaart, click its check box in the Use column. The API: Driver Name column lists 

the name that the audio device (or its driver) reports to the operating system. On macOS, all devices will use 

CoreAudio. Windows machines may have ASIO and Wave API devices, and some devices may appear as both 

types.  

Note: If you have both Wave and ASIO drivers installed for an IO device with more than two channels, it will 

typically show up as a single ASIO device, and multiple Wave devices, since the Wave API only supports two 

input channels per device.  

In the Friendly Name column, you can assign an alternative name to a device if you choose – remember to 

press the [Enter] key after typing the name to apply your change. 
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The Status column indicates either OK or N/C for each device. OK means that Smaart was able to successfully 

connect to the device and it is ready for use, while N/C means “not connected”. N/C can mean really not 

connected – Smaart remembers the device was connected previously, but it is no longer present – or it can 

indicate some hardware or software problem prevented Smaart from communicating with the device. This 

could be a device driver issue, a loose cable, or the device needs to be restarted. You can remove an N/C 

device by selecting it in the list and clicking the Remove button to the bottom right of the devices table.  

Enabling a device for use in the devices table will create a tab for it below the device table. The Input Channels 

table has 6 columns, the last of which is a live signal input meter for each input. 

The check boxes in the Use column allow you to select the inputs you want to use in Smaart and ignore the 

rest. Note: clicking directly on the word Use in the column header will quickly select / deselect all inputs at 

once. The Ch column lists the channels by number, and Channel Name lists the driver-reported channel name 

for each.  

You can assign a Friendly Name for each channel to help you identify it when you see it elsewhere within 

Smaart – make sure to press the [Enter] key to set the name after you’re done typing and move down to the 

next channel on the list.  

The Cal Offset column indicates the calibration offset for sound level measurements. A calibration offset of 

zero means the input is not calibrated for sound level measurements. Once the input has been calibrated, the 

Cal Offset value displayed corresponds to the acoustic level at the microphone that will bring that input’s 

convertor to 0 dBFS.  

Below the Input Channels table is a Clear Settings button which will reset the device’s configuration by 

clearing out all calibration offsets, microphone correction curves, and friendly names. To the right, the 

Calibrate button opens the Amplitude Calibration dialog and defaults its selection to the currently selected 

input.  

CALIBRATION PROCEDURE 

To complete the sound level calibration routine, you will need a sound level calibrator, which is a device that 

produces a known SPL at the diaphragm of the microphone, which Smaart can correlate with the incoming 

signal level, thus establishing the sensitivity of the entire input signal chain, from microphone to AD convertor. 

A sound level calibrator is a precision device that fits snugly over the measurement microphone capsule and 

generates a known acoustic level. Most calibrators produce levels of 94, 110 or 114 dB SPL, but it is not critical 

which level your calibrator produces as long as it is known. If your calibrator offers a choice, there is a slight 

advantage to using the higher level because it increases the signal to noise ratio of the calibration process and 

makes external and ambient noise less likely to disrupt the process.  

When you insert your measurement microphone into the sound level calibrator, do so slowly, to avoid 

shocking and potentially damaging the microphone diaphragm. Most calibrators use a rubber seal or gasket of 

some type to ensure a proper seal. The fit should be snug, without wiggling or play. If you can clearly hear the 

calibrator’s tone once you turn it on, you may not have a solid seal.  

Once the calibrator is properly seated and is switched on, open Smaart’s Amplitude Calibration dialog by one 

of the following: 
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• Clicking the Calibrate button at the bottom of the Control Bar 

• Clicking the Calibrate button at the bottom of the IO Config dialog 

• via Config > Amplitude Calibration 

The Amplitude Calibration dialog has dropdown menus at the top for you to select the device and input you 

wish to calibrate – ensure the selection is correct before you continue with the process. The Offset field 

displays the calibration offset for that input – the acoustic level that will bring the convertor to 0 dBFS. If the 

input hasn’t yet been calibrated, this number will be 0.0. The level meter on the right shows the signal level for 

the selected input, with a bit of time averaging applied to smooth out the reading, and should reflect the level 

of the input signal as caused by the calibrator. Once you have adjusted the input preamp to achieve the 

desired digital level, click the Calibrate button to run the calibration routine.  

 

Figure 8 - Amplitude Calibration dialog 

While the calibration process runs, avoid bumping the microphone and calibrator or making unnecessary 

noise. Once the process completes, it displays the measured digital level in dBFS RMS. Smaart will then ask 

you what acoustic sound level corresponds to this measured digital level. Enter the level produced by your 

calibrator into the Set this value to: field and press [Enter]. The Offset Required value displays the resulting 

calibration offset, which is the highest sound level that can be accommodated by your measurement setup in 

its current configuration without overloading your convertor. Click Okay to set the offset and close the dialog. 

 

Figure 9 - the Calibration Progress dialog 
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Note that calibration describes the sensitivity of the entire signal chain from microphone to convertor, so if 

you plug in a different measurement microphone or adjust your interface’s preamp gain, you will need to run 

the calibration procedure again to determine the new offset, unless you are using an interface with Gain 

Tracking (see below). 

GAIN TRACKING 

If you are using the Audient evo8, evo16, or the Roland OCTA-CAPTURE as your Smaart SPL interface, Smaart 

can communicate with the device to read and adjust preamp gain settings. If one of these devices is detected, 

a Gain Tracking checkbox will be displayed below the Channels list in the IO Config dialog. After the calibration 

process is completed, select the Gain Tracking check box to allow Smaart to automatically adjust calibration as 

the preamp level is adjusted. Note that when using evo devices, the evo application should be launched 

before launching Smaart in order for the Gain Tracking functionality to be enabled. 

 

Figure 10 - the Gain Tracking checkbox in the lower right corner enables gain tracking when supported hardware is detected 

When the docked meter bridge at the top of the interface is expanded, and a device that supports preamp 

control is recognized, preamp controls will be shown next to each input’s meter. 

 

Figure 11 - preamp controls visible in the docked meter bridge at the top of the interface 

Additionally, you can open the Input Meters window (View > Input Meters > Input Meters) or [Shift] + [E]. A 

meter strip will be visible for every input selected for use in Input Config. Adjust the gain slider to adjust 

interface preamp gain.  
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Figure 12 - Input Meter with gain tracking controls 

The accuracy of these adjustments is device-dependent but will typically range within a maximum error of 

about ± 1.5 dB from nominal gain setting, between 0 and 50 dB, when calibrated at a gain setting of 25 dB. To 

quickly determine the maximum gain adjustment error for your specific device, set input to a gain to 25 dB, 

then calibrate for sound level measurements with Gain Tracking turned off. After calibrating, with the 

calibrator still fitted to the microphone and turned on, enable Gain Tracking and assign the input to an SPL 

meter in Smaart, then observe the measured level as you turn the gain up to 50, and down to 0 dB. The 

maximum deviation observed from the reference level of the calibrator represents the maximum expected 

accuracy of your setup. 

DISPLAY CONFIG 

You can access display settings by clicking Config > SPL Config to open the SPL Config dialog to the Display tab. 

This dialog is home to several settings that control the way that timeline and meter data is displayed in Smaart 

SPL. 

 

Figure 13 - Display settings 



4 – Working With Smaart SPL 
 

Smaart SPL User Guide 29 Release 9.1 

Line Thickness allows you to set the thickness of the history timelines traces. Two dropdowns are available: 

Foreground sets the thickness of the trace on the top of the z order, in pixels. Background sets the thickness 

for all remaining history plot traces, in pixels. 

The Meter Display Settings field allows you to customize the Red, Yellow and Green color thresholds for Peak, 

dB SPL, and Leq metrics independently or all at once.  

SKINS 

Smaart has two built-in color schemes, the Default Dark scheme that you see the first time you run the 

program, and a Default Light scheme that uses dark text against a lighter background. Default Dark works well 

indoors, particularly in darkened rooms. Default Light might be a better choice in brightly lit environments, or 

when making screenshots for printed documents or presentations.  

You can change between them using the View > Skins menu, cycle through all available skins using the hotkey 

[Ctrl/Cmd] + [Shift] + [X].  

In addition to the built-in defaults, Smaart also allows you to define custom color schemes (“skins”) via the 

Skins tab of the Options > Preferences dialog.  

 

Figure 14 - Skin Manager 

The Skins tab is divided into two sections, Color Picker and Skin Manager. The Color Picker section consists of 

color tiles showing the color assignments for various interface elements in the current color scheme. Each 

color tile is a button that opens a Color Selection dialog. Color changes take effect immediately when you click 

Apply in the color selector. 

The Skin Manger section lists all available color schemes. Since the Default Light and Default Dark skins can’t 

be altered, making a change while one of them is the active skin will create a New Custom Skin using either the 

Default Light or Default Dark skin as a starting point. You can rename a custom skin by double-clicking it in the 

list and typing a new name. Custom skins update with any changes in real time. The Restore Defaults button 
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will restore all colors in the custom skin to match either the Default Light or Default Dark skin on which it was 

based. Save As will save a copy of the skin with a new name. Load will select a skin for use, and Delete will 

delete the custom skin. 

Custom skins are stored in the Documents\Smaart SPL\Skins directory as .xml files, so you can move them to 

other computers or share them with friends by placing the files in this folder. 

CONFIGURING METRICS 

By default, Smaart SPL offers 15 sound level metrics in addition to the digital full-scale signal level (dB FS 

Peak). Ten of these are hard-coded and always enabled: SPL Fast, SPL Slow and Leq 1, each in three weightings 

(A,C and unweighted), and Peak C. In addition, the Custom Metrics table is populated by default with Leq 10 in 

the same three weightings, plus both variants of sound exposure (Exposure O and Exposure N).  

The Custom Metrics table is accessible via Config > SPL Config and then clicking the Custom Metrics tab. 

Alternatively you can click the Log Config button in the Control Bar and then click over to the Custom Metrics 

tab.  

 

Figure 15 - adding a new custom metric via the Custom Metrics table 

Add a new custom metric to the table by clicking the [+] button in the lower left corner of the dialog. You can 

add an unlimited number of custom metrics – if you accidentally duplicate an already-configured metric, 

Smaart will simply remove the duplicate for you when you close the dialog.  

Custom metrics can be dB Leq, dB SPL Fast, dB SPL Slow, Peak, Exposure O or Exposure N.  
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CUSTOM LEQ METRICS 

For Leq metrics, enter a time period in minutes in the Time field. You can also use “s” for seconds or “h” for 

hours. For example, enter “10s” for a ten second Leq. Smaart SPL will allow you to create Leq metrics in any 

length from 1s to 24h. Use the dropdown in the Weight column to select None, A, C, C-A, or Octave weighting. 

Selecting Octave will enable the Frequency dropdown for you to select octave bands on centers from 16 Hz to 

16 kHz.  

CUSTOM SPL FAST AND SPL SLOW METRICS 

Since all broadband (A/C/unweighted) variants of dB SPL Fast and Slow are already permanently configured as 

options, custom dB SPL Fast and dB SPL Slow metrics are automatically set to Octave weighting. Use the 

Frequency dropdown to select an octave band from 16 Hz to 16 kHz.  

CUSTOM PEAK METRICS 

In addition to the permanently configured Peak C metric, you can add additional  Peak metrics with A 

Weighting, no weighting, or Octave weighting. If you select Octave weighting, the Frequency dropdown will 

allow you to select an octave band from 16 Hz to 16 kHz.  

CUSTOM EXPOSURE METRICS 

By default, both exposure metrics (O and N) are configured as custom metrics in the table, however if you 

removed one and want to recreate it, you can do so by selecting either Exposure O or Exposure N from the 

dropdown. Exposure metrics are simple dosimeters and have no user-configurable options. 

CONFIGURING METERS 

In Smaart SPL, there are two banks of sound level meters. The first is the docked meter bridge that appears 

across the top of the main program window and displays a single meter for each enabled, calibrated input. 

Each meter can be set to display any configured metric. The docked meter bridge can be hidden by clicking the 

disclosure arrow below the meter bridge. See Figure 11. 

Additionally, Smaart SPL features a floating meter grid in a separate, resizable window that can contain a user-

configurable number of meters. Each meter can display any configured metric for any calibrated input and be 

given a custom user-assigned name. Show the meter grid by clicking the Show Meter Grid button in the 

Control Bar, or by pressing [E] on your keyboard. 
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Figure 16 - Meter grid in running mode (left) and config mode (right) 

Click the hamburger (three-line) icon in the top corner of the meter grid window to open the SPL meter 

hamburger menu, and choose Enter Meter Grid Config to put the meters into Config mode. In Config mode, 

small borders appear along the right and bottom edges of the meter grid containing [+] and [-] buttons that 

control the number of meters in the rig.  

Clicking the [+] on the right edge will grow the meter grid horizontally by adding another column of meters, 

and the [-] will shrink it by removing a column. Clicking the [+] on the bottom edge will grow the meter grid 

vertically by adding another row of meters, and the [-] will shrink it by removing a row.  

Type a name for each meter in the Name field, and use the Device and Channel dropdowns to assign any 

calibrated input to the meter. 

When you are done configuring the meters, choose Exit Meter Grid Config from the hamburger menu. The 

dropdown metric selection menu at the bottom of each meter can be adjusted even if the meters are not in 

Config Mode. You can also resize the entire meter grid window by dragging the resize handle in the bottom 

right corner, whether or not the meters are in config mode. 

CONFIGURING ALARMS 

Alarms notify the operator visually when a specified metric exceeds a specified level, and the alarm 

occurrence is logged in the log file. Alarms are configured in Config > SPL Config in the Alarms tab. Each entry 

in the table represents an alarm. Select the Use checkbox to enable the alarm. Select from configured inputs 

with the Input dropdown, or All Calibrated Inputs for a global alarm, and then choose the metric that you 

would like to use for the alarm trigger in the Type dropdown, which lists all configured metrics. The Level (dB) 

field sets the alarm threshold, and Duration sets the amount of time, in seconds, that the associated meter 

will flash a visual warning when the alarm is triggered. 
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Figure 17 - Alarms tab 

Click the [+] button in the lower left corner to add a new alarm, or the [-] button to remove the selected alarm 

from the list. 

LOGGING 

When logging is enabled, the values of all configured sound level metrics are written to a timestamped logfile 

every logging interval. The default logging interval is three seconds, and can be adjusted in Logging tab of SPL 

Config, which is accessible directly by clicking the Log Config button in the Control Bar. For “short term” 

metrics (Peak, SPL Fast and SPL Slow), the highest level reached during the logging interval is recorded so that 

no maximum values are missed. “Long term” metrics (Leq and Exposure) are logged at their present value.  

Engage logging by clicking the Start Logging button in the Control Bar, which will turn red. Logfile data will 

begin to populate the SPL History Timeline. Logging will continue until it is stopped by clicking the Stop Logging 

button. Once logging is stopped, the logfile will appear in the SPL Data Bar along the left side of the screen.  

The logging status is persistent, such that if you close Smaart SPL while logging is running, the program will 

automatically begin logging again the next time it is opened.  

At any point during logging, you can click the Add Note button in the Control Bar to add a timestamped 

lollipop marker to the timeline at the current time, with a customizable text note. This is helpful to mark 

certain events such as set changes, pyro cues, and so forth, for later review.  

LOLLIPOP MARKERS 

Smaart SPL uses color-coded “lollipop” markers in the SPL History Timeline to indicate certain events. 
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Figure 18 - a portion of SPL History Timeline data showing two alarm markers (orange), an overload marker (red), a note marker (pink) and 

an Leq reset marker (black) 

NOTES (PINK) 

Notes added to the timeline via the Add Note button in the Control Bar are indicated as pink lollipop markers 

at the corresponding timestamp. Hover your cursor over the marker to see the associated note text. 

LEQ RESET (WHITE / BLACK) 

When Leq buffers are manually reset (either by using the Reset button in the Control Bar or the SPL Meter 

Grid right click menu, the reset operation is indicated by a white lollipop marker in the timeline when using 

the dark interface color scheme, and a black lollipop marker when using the light interface color scheme. 

ALARMS (ORANGE) 

Whenever a metric’s logged value exceeds the corresponding alarm threshold for that metric, an orange 

lollipop will indicate that the alarm has been triggered. The alarm state will persist until the metric’s measured 

value drops below the alarm threshold. Hover your cursor over the marker to see the metric associated with 

the alarm.  

OVERLOADS (RED) 

When Smaart detects an overload condition in an incoming signal (three consecutive samples at 0 dBFS), all 

averaging buffers will be flushed to remove the undefined values, and will begin to refill as soon as the 

overload condition passes. Overload events are logged into the logfile and indicated in the SPL history timeline 

as a red lollipop marker, and on the meter grid by a red status indicator and the word “OVERLOAD”. 

WORKING WITH THE METER GRID 

Whenever sound level data is being logged and/or displayed on a meter, Smaart calculates data for all 

configured metrics, so you can switch between any of them without having to wait for averaging buffers to 

refill for a newly displayed metric. 

Meters with Leq metrics assigned to them display a horizontal bar that reflets the state of the Leq buffer. The 

bar is yellow when the buffer is partially full and gradually extends across the face of the meter, turning green 

when the buffer is full. Hover your mouse cursor over the bar to see the buffer status.  
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The Max indicator shows the highest value reached by that metric. Click the colored circle icon to the right to 

reset the Max value. The circle icon turns green in the presence of signal and indicates a “healthy” meter, and 

turns red in the case of overload (see above).  

Right click in the center of a meter to open a pop-up menu with two options: Reset Leq buffers for this input, 

and Reset Exposure for this input.  

You can also choose to globally reset max levels, Leq buffers, or exposure by using the Reset button in the 

Control Bar.  

WORKING WITH LOGFILE DATA 

In both the Navigation pane and the Detail pane, the Friendly Name of the input generating the data is 

displayed in the upper right corner of the plot. Immediately below is the name of the currently displayed 

metric. Click the metric name, or the white arrow next to it, to open the metric selection droplist. The droplist 

displays all metrics contained in the current logfile. Check the box next to a metric to select it for display in the 

timeline.  

 

Figure 19 - Metric selection droplist 

You can click the name of a metric to bring it to the top of the z order or use the [Z] key on your keyboard to 

cycle metrics to the top of the z order. The metric that is currently at the top of the z order is also the metric 

displayed in the top (Navigation) pane.  

The navigation pane will always automatically scale itself in both the horizontal and vertical dimensions to 

display the entire logfile. The detail pane will also automatically set its vertical scale as metrics are shown and 

hidden to properly accommodate the data being displayed and can be zoomed in or out vertically by pressing 

the [+] and [-] keys on your keyboard. Return the vertical scaling to default (auto-fit) by clicking anywhere in 

the plot border.  

SELECTING A TIME RANGE 
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You can focus the detail plot in on a specific time range by dragging the arrowhead-shaped widget handles 

that appear in the lower edge of the navigation plot. The time range that you have bound by the widgets in 

the navigation plot will fill the detail plot. By default, they appear in the bottom left and bottom right corners 

to indicate that the entire time range is shown in the detail plot. Dragging them inwards selects a shorter time 

range. The portions of the timeline data that lie outside the selected time range will be shaded to indicate 

they are not displayed in the detail plot. You can also enter a time range direction into the Time Range field in 

the lower right corner, below the detail plot. For example, type 32:00 to set the time range to 32 minutes. 

 

Figure 20 - Using the time range sliders in the navigation pane to view 52 minutes and 24 seconds of log data in the detail pane 

When the selected time range is shorter than the total logfile duration, hovering the mouse cursor over the 

navigation pane between the two time range selection widgets will turn the cursor into a hand icon. Click and 

drag left or right to move the selected time range. For example, if you have a five minute time range selected, 

you can slide that 5 minute selection left or right to see a different five minutes’ worth of data in the detail 

pane. Sliding the selection all the way to the right side of the navigation plot (most current data) will force 

Smaart to always show the most recent data as logging continues. 

STATISTICAL ANALYSIS (DYNAMIC RANGE STATISTICS) 

Below the detail pane, across the bottom of the main program window, is the statistics bar. This bar displays a 

statistical analysis of the data appearing within the selected time range, for the metric on the top of the z 

order. For most metrics, the statistics bar displays Max, L10, L50 and L90 data for the selected time range.  

 

Figure 21 - Time Range statistics bar 
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Max is the highest value logged for the metric within the selected time range. 

L10 is the level that was exceeded by 10% of the data points within the selected time range. 

L50 is the level that was exceeded by 50% of the data points within the selected time range. In other words, 

the median level. 

L90 is the level that was exceeded by 90% of the data points and is sometimes regarded as a useful indicator 

of background or ambient noise levels. 

When Exposure O or Exposure N data is is the selected metric (on top of the z order), the statistics bar instead 

changes to display Max, Min and Delta. 

 

Figure 22 - Exposure Statistics 

Max is the highest exposure value logged within the selected time range, in percent. 

Min is the lowest exposure value logged within the selected time range, in percent. 

Delta is the difference between Max and Min, or otherwise, the sound exposure dose accumulated in the 

selected time range, in percent. 

INCOMPLETE FILES 

While logging is in progress, the data is held in a temporary text file located in the same directory as your 

session folder. Once logging is completed, the logfile data is finalized, column headers, statistical analysis data 

and other information are added, and then the finalized logfile is saved with an automatically generated name 

in your session folder.  

If logging is interrupted without properly closing Smaart (a crash or the computer is shut down improperly 

etc), this process will be interrupted. Although the temporary logfile is not directly Smaart-readable as a 

logfile, it does contain the log data so no data loss occurs. To manually recover log data in the event of an 

interrupted logging session, it is recommended to start logging again, allow it to run for a few seconds, then 

stop it, which will generate a proper logfile reflecting the current program configuration, and including 

accurate column headers for the configured metrics. The temporary data can then be copied into this logfile 

using a text editing program and it should line up with the proper header format. For help reformatting 

orphaned log data in the event of a failure, please contact Rational Acoustics support.  

GENERATING REPORTS 

The Generate Report feature allows you to export a PDF report for the selected time range, including a variety 

of user-editable details, statistical data for configured metrics, and optionally history thumbnail graphics. Click 

the Create Report button in the Control Bar to open the Generate SPL Report dialog. The left side of the dialog 
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contains user-editable text fields for Operator, Company, Venue, Event, Engineer, Production Company, and a 

general Notes field.  

 

Figure 23 - Generate SPL Report dialog 

The right side of the dialog is the History Thumbnails menu. The Include History Thumbnails checkbox is 

selected by default – un-check it if you wish to exclude the history thumbnail graphics from the report. All 

metrics included in the logfile data are available in the list; select the checkboxes for those which you wish to 

include thumbnails for in the report. By default, the selected metrics will match the metrics that were visible 

in the SPL History Timeline when the Create Report button was clicked. You can also quickly Select All  or 

Select None using the buttons below the metric list. 

Click the Create button to create the SPL PDF report and export it to the SPLReports directory located in 

Document\Smaart SPL\Data\SPL Logs\SPLReports. Selecting “Open file location when done” before creating 

the report will open your operating system’s file browser to the report directory so you can easily access the 

report. Selecting “Email Report” will change the Create button to read Create and Email. Once you click it, 

Smaart will attempt to launch your operating system’s default mail browser with the PDF report attached to a 

new email draft. 

SPL WEBVIEWER (SMAART API) 

Smaart SPL allows realtime remote viewing of the SPL history timeline data, meters, and alarms via a web 

browser on a computer or mobile device that shares a network connection with the computer running Smaart 

SPL .  
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Figure 24 - API settings for SPL webviewer 

Logging must be running for the API to be enabled. Once logging has begun and the SPL History Timeline starts 

to populate with log data, open the Options menu and choose API. If desired, you can enter a password. Client 

machines will be prompted to enter the password when connecting to the webserver. Then select the 

“Enabled” checkbox to start the webserver running. The status indicator circle will turn green.  

The IP address field displays the host computer’s IP address. If the machine has multiple valid IP addresses or 

network adapters, all of them can be used to connect to the Smaart API. Hovering your cursor over the 

displayed IP address to show a popup displaying all valid IP addresses for that machine.  

Connect to the web viewer from client devices by opening a web browser and entering either the IP or 

hostname, followed by a colon and the port number, as displayed in the API options tab, for example 

“192.168.1.117:26000”  

You can test the web server by connecting to it from a web browser on the host machine by entering the 

hostname “localhost” and the port (locahost:26000).  
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Figure 25- SPL Webviewer running in a web browser 

We recommend using your web browser’s private browsing / incognito mode, as it disables scripts and plugins 

that can interfere with the API’s functioning.  

Multiple client devices can connect to a single instance of the Smaart SPL webserver, and client devices can 

connect multiple browser tabs or windows to multiple instances of Smaart SPL, for example, to view levels on 

multiple stages at a music festival.  
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